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This guide provides the information 
required to set up and begin using 
your new SMART-MR15, a combined 
L1+L2 GNSS receiver and antenna 
with an integrated cellular modem with 
NTRIP correction support. The 
SMART-MR15 also provides 
Bluetooth® 2.0 wireless connectivity 
and Emulated Radar (ER) output.

For more detailed information about the installation and 
operation of your receiver, refer to the SMART-MR15 and 
OEMV® user manuals, which can be found on the NovAtel Web 
site at:

www.novatel.com/support/firmware-software-and-manuals/ 

SMART-MR15 BOX CONTENTS

In addition to this quick start guide, the following are provided 
with your SMART-MR15:

• 1 - SMART-MR15 cellular activation guide

• 1 - CD containing: 

• An installation program for the NovAtel PC Utilities

• Product documentation

• 1 - User Manual postcard for requesting printed manuals

AVAILABLE ACCESSORIES

The following SMART-MR15 interface cables can be ordered as 
accessories:

• Evaluation cable (NovAtel part number 01018515) with 
a 23-pin connector on one end and three DB-9 
connectors and exposed tinned wires for power, ER, 
ground, MKI, MODE, PPS and CAN, on the other. This 
cable is designed to allow the rapid deployment and 
evaluation of a SMART-MR15 on a construction or 
agricultural vehicle. All signals are wired out in this 
cable. The Evaluation cable is not intended for 
permanent installations.

• Streamlined cable (NovAtel part number 01018526) with 
two DB-9 connectors, and exposed tinned wires for 
power, ground and ER. This cable provides connection 
for power, two serial ports, and emulated radar. It has 
been designed for permanent installation. The cable 
material is capable of withstanding a wide temperature 
range and is not damaged by exposure to chemicals.

Four mounting kits are available for the SMART-MR15:

• Mounting Kit, Quick Release Plate (01018625)

• Mounting Kit, Quick Release Assembly (01018578) 

• Mounting Kit, AG GPS 262 (01018623)

• Mounting Kit, 5/8 Inch Adapter (01018624)

In addition to the above cable and mounting accessories, the 
following accessories are available for the SMART-MR15:

• CDMA Antenna, 2.2 / 4 dBi, 824-896 MHz / 1850-1990 
MHz, NMO [NovAtel part number 12023296] (USE with 
12023301 mount only)

• CDMA Antenna Base, NMO Magnetic Mount, 30 cm 
cable [NovAtel part number 12023301] (USE with 
12023296 CDMA Antenna. DO NOT USE with 
12023303 GSM/GPRS/HSDPA Antenna) 

• GSM/GPRS/HSDPA Antenna, 3 / 4 dBi, 806-960 MHz / 
1710-2500 MHz, NMO [NovAtel part number 12023303]. 
(USE with the 12023300 GSM/GPRS/HSDPA mount 
only. DO NOT USE with 12023301 CDMA Base).

• GSM/GPRS/HSDPA Antenna Base, NMO Magnetic 
Mount, 3.65 m cable [NovAtel part number 12023300] 
(USE with 12023303 GSM/GPRS/HSDPA Antenna only)

• Antenna Ground Plane Kit, for use on non-metallic 
mounting surfaces [NovAtel part number 01018684] 

ADDITIONAL EQUIPMENT REQUIRED

The following additional equipment is required for basic setup:

• A Windows®-based computer with an RS-232 DB-9 port.

• A battery connection (+9 to +36 V DC)

INSTALLING THE PC UTILITIES

Before setting up your SMART-MR15, install NovAtel’s PC 
Utilities on the Windows-based computer that you will use to 
communicate with it. This computer must have an RS-232 DB-9 
port.

1. Start up the computer.

2. Insert the accompanying CD into the CD-ROM drive of the 
computer.

3. Select Install the OEMV PC Utilities from the window that is 
automatically displayed. If the window does not 
automatically open when the CD is inserted, select Run from 
the Start menu and select the Browse button to locate 
Setup.exe on the CD drive.

4. Install the PC Utilities by advancing through the steps 
provided in the NovAtel GPS PC Utilities setup program. 

SETTING UP YOUR SMART-MR15

 Figure 1:  SMART-MR15 System Diagram

The SMART-MR15 system architecture is shown in Figure 1. For 
the basic setup, you need a Windows-based computer with an 
RS-232 DB-9 port and NovAtel PC Utilities installed on it, and a 
battery connection (+9 to +36 V DC). Complete the following 
steps to connect and power your receiver.

1. Mount the SMART-MR15 on a secure, stable structure with 
an unobstructed view of the sky. Mount the cellular antenna 
at least 30 cm from the SMART-MR15.

2. Connect the interface cable to the SMART-MR15.

QUICK START GUIDE

 To access and download the most current version of our 
OEMV PC Utilities, go to the Support page of the NovAtel 
web site at www.novatel.com.
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3. Connect the SMART-MR15 to a DB-9 serial port on the 
computer.

 Figure 2:  SMART-MR15 Cabling

4. Provide power to the SMART-MR15, as follows: 
Connect the red wire of the cable (PWR+, connector pin 1) 
to the positive side of a 12 or 24 V vehicular power circuit (or 
equivalent) that is protected by a 5 A fuse. NovAtel 
recommends an automotive blade-type fuse, rated for 5 A 
and with an operating voltage of more than 36 V 
(recommended fuse part numbers are in the SMART-MR10/
15 User Manual). 
Connect the black wire of the cable (PWR-, connector pin 9) 
to the negative side of the power circuit. 
If a NovAtel-supplied SMART-MR15 cable is not used, a 
minimum wire size of 0.5 mm/ 20 AWG is required.

5. Connect the cellular antenna to the SMART-MR15.

6. Obtain a valid data SIM and insert into the unit 
(GSM/GPRS/HSDPA model only) or activate the product 
with Verizon (CDMA model only). Refer to the cellular 
activation guide for details.

SMART-MR15 LEDS

LEDs on the front of the SMART-MR15 provide basic receiver 
status information. The operation of the LEDs on the
SMART-MR15 is summarized in the following table:

SMART-MR15 CABLES

Cable connectors are illustrated in Figure 3. One DB-9 
connector can be used to connect to a computer serial (RS-232) 
communication port. The others can be connected to a modem 
or radio transmitter to receive differential corrections (refer to 
your user-supplied modem or radio transmitter information for its 
connectors). In addition, there are a number of bare wires where 
the outer insulation is cut away at the ends to expose tinned 
wires. Refer to the SMART-MR10/15 User Manual for cable 
pinouts. Cables are RoHS compliant.

The SMART-MR15 cable provides a means of receiving power 
from a battery. The bare power wires (red for positive and black 
for negative) are connected to a battery capable of supplying at 
least 5 W. A 5 A fuse must be installed between the positive 
terminal of the battery (or power distribution point) and the 
positive supply lead of the cable to protect the wiring from short 
circuit damage.

 Figure 3:  23-pin and DB-9 Connectors
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 Table 1:  SMART-MR15 LED Behavior

Red Yellow Green

Condition

Off Off Off Power is not available (Red indicator may 
also not be lit if a boot failure has occurred).

Flashinga

a. Flashing means that the LED is turning on and off at a 1 Hz rate - 0.5 seconds on 
and 0.5 seconds off.

Any Off
A SIM card error is present or the SIM may 
not be installed. Applies only to GSM/
GPRS/HSDPA version of SMART-MR15.

On Off Off Power available, but no satellites are being 
tracked. No cellular network connection.

On Flashing Off Tracking at least one satellite, but not a valid 
position. No cellular network connection.

On On Off Position valid in basic autonomous mode. 
No cellular network connection.

On On Flashing Connected to cellular network, but not 
receiving RTK corrections over NTRIP.

On Flashing Flashing
Tracking at least one satellite, but not a valid 
position. Connected to cellular network, but 
not receiving RTK corrections over NTRIP.

On On On

The following conditions are true:
• A valid position is available.
• The NTRIP client is in a STREAMING 

state.
• An RTK solution is available over NTRIP.

 Table 2:  SMART-MR15 Evaluation Cable

TYCO
23-pin 

COM1 COM2 AUX TINNED LEAD SIGNAL NAME

1 PWR+ (red) PWR+

2 PWR- (black) PWR-

3 CAN- (green) CAN-

4 CAN+ (yellow) CAN+

5 2 AUXTX

6 3 AUXRX

7 2 TXD1

8 2 RTS1

9 SIGGND2
(white/black)

SIGGND2

10 RESERVED

11 RESERVED

12 RESERVED

13 RESERVED

14 CHASSIS GROUNDa

a. Pin 14 of the TYCO 23-pin connector is connected to cable shields.

15 5 5 5 SIGGND1
(white/ black)

SIGGND1

16 MKI (white) MKI

17 PPS (orange) PPS

18 ER (blue) ER

19 MODE (violet) MODE

20 RESERVED

21 RESERVED

22 3 CTS1

23 3 RXD1



COMMUNICATING WITH THE SMART-MR15

To open a serial port to communicate with the receiver, complete 
the following steps.

1. Launch Connect from the Start menu folder specified during 
the installation process. The default location is Start | 
All Programs | NovAtel PC Software | NovAtel Connect.

2. Select New from the Device Menu.

3. Enter a name for the Connection setup.

4. Select Serial from the Type list.

5. Select the computer port to which the SMART-MR15 is 
connected, from the Port list.

6. Set the COM port for the receiver to communicate through.

7. Select 115200 from the Baud Rate list. 

8. Ensure the Hardware Handshaking box is not checked and 
press OK.

9. From the Device menu select Open Connection.

10. Select the Open button to open SMART-MR15 
communications.

Connect establishes the communication session with the 
receiver and displays the progress. Once connected, the 
progress box disappears and several windows open, includ-
ing the Console window. Connect is now ready for use to 
view status information, enter commands or log data.

USING NOVATEL CONNECT

Connect provides access to key information about your receiver 
and its position. The information is displayed in windows 
accessed from the View menu. For example, select Position 
Window from the View menu to display the position solution of 
the receiver. To show details of the GNSS and geostationary 
(SBAS) satellites being tracked, select the Tracking Status 
Window from the View menu. Select Help from the main menu 
for more details on Connect, its windows and features.

DETERMINING WHEN THE POSITION IS VALID

When the receiver has a valid position, the Solution Status field 
in Connect’s Position window shows Computed:

ENTERING COMMANDS

The SMART-MR15 uses a comprehensive command interface. 
Commands can be sent to the receiver using the Console 
window in Connect, which is opened from the View menu. Enter 
commands in the text box at the bottom of the Console window.

 Table 3:  SMART-MR15 Streamlined Cable

TYCO
23-pin

COM1 COM2 TINNED LEAD SIGNAL NAME

1 PWR+ (red) PWR+

2 PWR- (black) PWR-

3 RESERVED

4 RESERVED

5 2 AUXTX

6 3 AUXRX

7 2 TXD1

8 RESERVED

9 SIGGND2
(white/black)

SIGGND2

10 RESERVED

11 RESERVED

12 RESERVED

13 RESERVED

14 CHASSIS GROUNDa

a. Pin 14 of the TYCO 23-pin connector is connected to cable shields.

15 5 5 SIGGND1
(white/black)

SIGGND1

16 RESERVED

17 RESERVED

18 ER (blue) ER

19 RESERVED

20 RESERVED

21 RESERVED

22 RESERVED

23 3 RXD1
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The OEMV Family Quick Reference Guide, available on the CD 
or on our Web site, provides comprehensive information about 
available commands. The SMART-MR10/15 User Manual 
provides information on a subset of these commands; in 
particular, the ones commonly used by the SMART-MR15.

SAVECONFIG COMMAND

If you change the configuration of a function and want to save 
the new settings for your next session, use the SAVECONFIG 
command. 

CELLULAR ACTIVATION

Follow the procedure outlined in the cellular activation guide 
included with your SMART-MR15. To check cellular modem 
status information, enter log cellstatus.

CONFIGURING NTRIP

Obtain the following information from your NTRIP caster:

• IP address or domain name of caster 
(www.igs-ip.net in the following example)

• IP port (80 in the following example)

• Mount point (mountpoint in the following example)

• User ID and password (user_id and password in the 
following example)

• Type of corrections expected from the caster 
(rtcmv3 in the following example)

• Data rate for transmitting NMEA position logs (GPGGA) 
to caster (10 in the following example) 
(optional, see below)

Connect to the caster as shown in the following example:

ntripcaster www.igs-ip.net 80

ntripclient mount mountpoint user_id 
password rtcmv3 10  

To view NTRIP status and configuration, enter:

log ntripstatus

NMEA LOGS

To configure the receiver output through the command line:

1. Configure the communication port using the COM 
command. For example, to set COM port 1 to 9600 bps, no 
parity, 8 data bits, 1 stop bit, no handshaking, echo off, and 
break detection on, enter the following:

com com1 9600 n 8 1 n off on

2. Select and configure the NMEA string that you want to 
output through COM port 1. For example, to log gpgga 
(position system fix data and undulation) at 2 Hz, enter the 
following:

log com1 gpgga ontime 0.5

ENABLING SBAS POSITIONING

This positioning mode is enabled using the SBASCONTROL 
command, as follows:

sbascontrol enable auto

Once enabled, the Solution type field shown in Connect’s 
Position window changes from Single to SBAS, and you may 
see SBAS satellites in the Constellation window. SMART-MR15 
will track available SBAS satellites, including WAAS, EGNOS 
and other SBAS systems.

ENABLING GL1DE®

To enable GL1DE, enter the following commands:

pdpfilter enable

pdpmode relative auto

ENABLING Bluetooth WIRELESS TECHNOLOGY

Bluetooth wireless technology is configured on the 
SMART-MR15 COM3 internal port and is enabled by default.

To disable Bluetooth wireless technology:

btcontrol disable

To enable Bluetooth wireless technology:

btcontrol enable

For detailed information about the configuration and enabling of 
Bluetooth wireless technology on the SMART-MR15, refer to 
Chapter 5 Bluetooth Configuration in the SMART-MR10/15 User 
Manual.

USING THE CAN BUS
The CAN Bus is a serial bus that provides services for 
processes, data and network management. CAN Bus capability 
is available through the SMART-MR15 evaluation cable. 

The CAN module is activated by entering the command 
SETCANNAME 305. If this is followed by entering the 
SAVECONFIG command, the CAN module is activated 
immediately on all subsequent start-ups. The module supports 
NMEA 2000 Parameter Group Message (PGN): PGN 129029 
GNSSPositionData, PGN 129025 GNSSPositionRapidUpdate, 
and PGN 129026 COGandSOGRapidUpdate.

EMULATED RADAR (ER)
The SMART-MR15 provides an emulated ground speed RADAR 
pulse output. The enclosure outputs ER via the bare wire 
labeled ER on both the SMART-MR15 evaluation and 
streamlined cables. Refer to Appendix B.5 RADARCFG of the 
SMART-MR10/15 User Manual.

ER is enabled by default. To disable ER, use the RADARCFG 
command as follows:

radarcfg disable

The following command enables ER, sets frequency step to 
36.11 Hz/kph, update rate to 1 Hz and no smoothing:

radarcfg enable 36.11 1 1 2

To enable ER, for example, enter the following command:

radarcfg enable

The ER low and high pulse levels are within 0.5V of the ground 
and battery, respectively. Note this is not a logic level output. 
The rise and fall time is less than 1 ms. The ER outputs 
reference battery GND when the output is logic low. It outputs 
logic low until the vehicle speed is greater than 1 km/hr. It 
provides an output frequency that represents 36.11 Hz/km/hr 
(default value) with an effective range from 1 km/hr to 55 km/hr, 
and uses 2D velocity for near-horizontal applications. The 
default value can be changed to 26.11 or 28.12 Hz/km/hr using 
the RADARCFG command.

 When using NovAtel Connect to configure your receiver, 
ensure all of the graphical windows are closed before you 
issue the SAVECONFIG command.

 If connecting to an RTK caster that employs VRS 
technology, the data rate for transmitting NMEA positions to 
the caster must also be specified. For example, to transmit 
position messages to a network RTK caster every 10 
seconds, the following commands should be used:
ntripcaster www.igs-ip.net 80
ntripclient mount mountpoint user_id password rtcmv3 10

 NTRIP commands are save-configurable. After you save 
the settings, the SMART-MR15 automatically connects to 
the NTRIP caster after a power cycle. For more information 
about configuring NTRIP, refer to application note APN-057 
found on our Web site at http://www.novatel.com/support/
knowledge-and-learning/. 

http://www.novatel.com/support/knowledge-and-learning/
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LOGGING DATA

An extensive set of logs has been created to capture the data 
your SMART-MR15 receives and processes. These logs can be 
directed to a SMART-MR15 port (COM1 or AUX) and can be 
automatically generated when new or changed data becomes 
available, or at regular intervals. Available logs are listed in the 
OEMV Family Quick Reference Guide, found on our Web site at 
www.novatel.com through Support | Firmware/Software and 
Manuals.

To log data, use the LOG command. For example, to log the 
pseudorange position to COM 1 every 30 seconds, enter the 
following:

log com1 psrposb ontime 30

When requesting logs, you can request the output data in three 
formats:

• ASCII 

• Abbreviated ASCII 

• Binary 

Abbreviated ASCII is the best format to use when you want to 
work with the receiver directly and review individual log contents 
visually.

Refer to the SMART-MR10/15 User Manual (OM-20000130) or 
the OEMV Family Firmware Reference Manual (OM-20000094) 
for information about the LOG command.

If you prefer, Connect provides a graphical interface for 
configuring data logging. Select Logging Control Window from 
the Tools menu. In the Logging Control window, you can select 
which logs to capture and choose the ports to which you want 
the data sent. You can also specify a file in which to save the 
data.

When logging data through Connect, close all unused windows 
to maximize COM port throughput and receiver CPU 
performance.

QUESTIONS OR COMMENTS

If you have any questions or comments regarding your   
SMART-MR15 please contact NovAtel using one of these 
methods:

Email: support@novatel.com

Web: www.novatel.com

Phone: 1-800-NOVATEL (U.S. & Canada)
1-800-668-2835

1-403-295-4900 (International)

Fax: 1-403-295-4901

 SMART-MR15-specific logs are not included in the Connect 
drop-down menus.
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